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Getting started

Welcome to CLZ Games!
Thanks for downloading our CLZ Games app!
We hope you’ll enjoy using this app to catalog and manage your game collection.

Just getting started cataloging your games?

Then here’s how to add the first games to your database.

Already have a game database stored in your CLZ Cloud?

If you already have your games cataloged using our Game Collector or Game Connect, then start by
downloading your existing data from the CLZ Cloud.

Like what you see? Subscribe to the app!

CLZ Games is a subscription app. You need an active subscription to use the CLZ Games online services.

You can start a 7-day free trial from the app’s start-up screen. The free trial automatically continues into the
subscription of your choice. You can cancel your subscription anytime through the App Store (Apple) or Play
Store (Android).

TIP: After you added a few games, upload your database to CLZ Cloud, as an online back-
up and for syncing the data to other devices.*
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Adding your first games
CLZ Games lets you catalog your games without manually entering all game details. Just search our “Core”
online game database, by barcode or game title and all game details will be provided automatically,
including developer, publisher, game description, cover art, etc…

Now let’s you get you started.

1. Tap the Add Games button: .
2. In the Add screen, at the top, choose By Barcode.
3. Point the camera scanner at a game barcode until it scans it.
4. Now tap the big blue “Add x games to collection” button to add the games.
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Subscribing to CLZ Games
CLZ Games is a subscription app. You need an active subscription to use CLZ Games and its online
services.

Pricing:

• $1.49 per month, when paying monthly
or

• $14.99 per year, when paying yearly (~ $1.25 per month)

You can start a 7-day free trial from the app’s start-up screen. The free trial automatically continues into the
subscription of your choice. You can cancel your subscription anytime through the App Store (Apple) or Play
Store (Android).

Purchase a subscription from the CLZ Shop
If you purchase your subscription through the CLZ Shop, make sure you cancel your subscription in the
mobile app in order to activate your subscription.

1. Open CLZ Games on your mobile device
2. Tap the menu top left, and tap on Subscription Status.
3. Tap “Manage” or “Cancel” subscription and unsubscribe.
4. Purchase your CLZ Games subscription from the CLZ Shop
5. Your subscription will automatically activate in your mobile app.
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Downloading data from CLZ Cloud
Have you been using one of our other game cataloging solutions, like Game Collector or Game Connect, or
maybe the CLZ Games app on another device?
Then you probably already have an existing game collection stored in your CLZ Cloud account.

Here’s how to download your existing game data from the CLZ Cloud:

1. First login to the app using your existing CLZ Account:

• Tap the menu top left and tap “CLZ Account”.
• At the bottom, tap “I already have a CLZ Account >”
• Now enter your CLZ Account username or email address and your password
• Tap Log in!

When back in the app’s main screen:

1. Tap the menu top left and tap “Sync with CLZ Cloud”.
2. This will open the Sync screen, showing the number of changes to be downloaded.
3. Tap the “Sync Changes” button to start downloading your game data.
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Uploading data to CLZ Cloud
The CLZ Games app comes with cloud storage for your data, in our own CLZ Cloud system.

When you’re using CLZ Games, we strongly recommend using the CLZ Cloud to:

• Transfer your active subscription across mobile devices.
• Make an online backup of your game collection data.
• Synch your game data between devices (e.g. your phone and tablet).
• Sync data to/from our Game Collector or Game Connect software.

Here’s how to upload your game data to the CLZ Cloud:

1. Sign up for a CLZ Account.
• Tap the menu top left and tap “CLZ Account”.
• Now enter your email address and tap “Sign up!”
• You are now logged in.

2. Upload your data to the CLZ Cloud.
When back in the app’s main screen:

1. Tap the menu top left and tap “Sync with CLZ Cloud”.
2. This will open the Sync screen, showing the number of changes to be uploaded.
3. Tap the “Sync Changes” button to start uploading your game data.
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Adding games
You can add games to CLZ Games in a variety of ways. Select one of the methods below to learn how.

• Adding by Title
• Adding by Barcode
• Adding Manually
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Adding by Title
Here’s how to add a game to your collection by Title:

1. Tap the Add Games button: .
2. In the Add screen, at the top, choose Add by Title.
3. Optionally: Choose a platform by tapping All Platforms and pick one.
4. On the Title tab, start typing the first few letters of title of the game that you want to add. Up to 5

suggestion will appear instantly.
5. Tap the game you want to add
6. Now click the big blue “Add to Collection” button on the bottom right to add the game to your

database.
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Adding by Barcode

Adding games by scanning their barcode
If you are cataloging your newer games to CLZ Games, you can also scan their barcodes with your device’s
camera:

1. Tap the Add Games icon:
2. In the add screen, at the top, choose Barcode.
3. Point the camera scanner at a game barcode until the barcode and game title appear in the barcode

queue.
4. If you want, scan a couple of games this way.
5. Now tap the blue Plus icon and select “Add … games to collection” to add these games to your

database.
6. Tap the back button (top left) to go back to the app’s main screen showing your added games.

Removing barcodes from the barcode queue

• Remove all barcodes:Tap the CLEAR button, bottom left.
• Remove 1 barcode: Tap and hold on said barcode and remove it.

Devices that do not have an autofocus camera (particularly the iPad 2) can have difficulty
scanning. If you are unable to get a good scan, make sure you are in a well lit area.*
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Adding Manually
If you are unable to find a game in our central database or you don’t have an internet connection, you can
add it manually:

• Tap on the “Wrench” icon to access the Tools menu.
• Tap on Add Manually (use the dropdown menu at the top middle of the Add Panel)
• Enter as much information as you want about this game.
• Tap the cover and you can choose to use a saved image, or use the built-in camera of your device to

take a picture of the game
• Tap Add Game when finished.
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Field Defaults
The “Field Defaults” feature gives you the ability to set default field values for your new game additions. It
allows you to set the “Seen it” or “Read It” fields to Yes or No, preset the Owner field and a lot of other
fields.

To access and add values in the Field Defaults screen:

1. Tap “Menu > Field Defaults”.
2. Fill in a default value for any of these fields

For example: If you’ve set the default value for owner to your name, the next game you add, will
automatically get your name filled in as the owner of that game!
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Managing your database
Select your device to learn more about editing:

• Editing movies
• Removing movies
• Managing Pick Lists
• Updating from Core
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Editing games
After adding some games to your database, it’s time to start editing your entries to add personal information
(like purchase details, your own ratings and notes, etc…) or to edit the automatically downloaded data to
your own preferences.

This is done in the app’s Edit Game screen.

Opening the Edit Game screen
Here’s how to get to the Edit Game screen:

1. Tap the game you wish to edit

2. Tap the Edit Game button:

Making changes in the Edit Game screen
In the Edit Game screen you can:

• edit the information that was automatically downloaded from our Core online database, e.g.
◦ Title
◦ Release year
◦ Format
◦ Genres
◦ etc…

• add personal information, like
◦ Purchase date, store and price
◦ your personal rating
◦ personal notes
◦ owner info
◦ etc…
◦ change the cover image

Most fields can be directly typed in (like Title, Notes), other fields open a pick list screen for easy picking of
a new value without typing (like Genre, Format, etc..).

When you’re done making changes, tap the Done button at the top right to save the changes to the
database and return to the main screen.

TIP: use the arrow icons at the top to save your changes and immediately move to the next*
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Multi/Single pick list fields

Multi/Single pick list fields are the fields that open a pick list screen for easy picking. They have a couple of
buttons associated with them and it is important to know what they all do:

• Removes the format from that game entry.

• Edits that value for all games that have this value. Be careful: This affects all { that use this
format.

• Adds a value for that game entry. It opens up a pick list screen for easy picking of a new value
without typing. Pick one from the list, or tap the + button to add a new format to your format list. You
can manage this pick list using the Manage Pick List screen.

or previous game in your list, while staying in the Edit Game screen.
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Cover Images
You can use your device camera to take a picture and add it as cover image to a game

To edit a cover image:

1. Select an item.
2. Tap “Edit” bottom right.
3. Now go to the Cover tab (which is on the right, you may have to scroll the tabs to see it)
4. You can modify the cover image there.

To save a cover to your device, tap and hold on the cover.

Custom Image
This toggle will be automatically set when you replace the Core image. Once the Custom Image toggle is
set, that cover will automatically sync to and from the CLZ Cloud.
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Field Reference

Field types in the Edit Screen
In the Edit Screen you will find different field types:

1. Basic text fields: These allow you to just type any text in them.
2. Number only fields: You can only add numbers in this field (for instance an index field, or a price

field).
3. Multi/Single pick list fields: These allow you to pick 1 (or more) values from a list of predefined

values (and you can also add values to that list).

Fields in the Edit Screen
Most fields in the edit screen will be self explanatory. Find a couple of fields below that you may have
questions about:

• Cover
Add/Edit/Remove a cover here. More information about cover images.

• Sort Title
Store the Sort Title of the game title here. This is used if you want to sort your game in a different
place in the list. For Example, ‘The Witcher’ will have a sort title of ‘Witcher’ so that it sorts under W,
rather than T.

• Index
Store an index number for your game. Some users put stickers with the index number on their games
so they can easily locate them using the app. Therefor, each Index number is only used once. This
number gets filled in automatically, and it also automatically increments on each new game you add.

• Collection Status
Tap on it to select a different collection status. This can move your game from Wish List to “In
Collection” after you purchased it.

• Rating
Define your personal rating for a game, what did you think of it?

• Location
Define where the game is stored in your home (which room?), or in a 2nd home for instance.

• Storage Device
If you use storage devices to store your game discs in, you can use this field to put in the name of the
storage device.
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• Storage Slot
Define which slot of the aforementioned storage device this game disc is in. You can only fill in the
slot for the first disc.

• Store
Define where you purchased the game.

• Current Value
You can put a current value in this field to show what the game is worth right now. This field is not
filled in automatically.

• Condition
Define the condition of the game: is it in mint condition? Any scratches visible?

• Tags
You can add keywords to make the game easier to find in your app. By adding tags you can also
create Tag folders to quickly group your games on certain tags.

• Notes
Add your personal notes about the game, you can basically fill in anything you want here!
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Removing games

Removing one game from its details page
1. Tap “a game” to view the details.
2. Then tap the “Action” button at the bottom left.
3. Now tap “Remove”.

Removing multiple games in one go
Note: This method is only possible in list mode (not in cover wall mode).

1. Enter selection mode by tapping the button at the top.
2. Select all games you wish to remove.
3. Tap the “Action” button at the bottom right.
4. Tap “Remove”.

Remove entire collection
If you wish to remove your entire collection for whatever reason (maybe start over) you can do so from the
side-menu option “Clear Database”.

1. First, tap on the menu button to open the side menu:
2. Tap Maintenance.

3. Now, tap Clear Database.
4. Confirm your choice to clear your entire database from the device.
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Editing multiple in one go
You can edit multiple games in one go by using the Edit Multiple screen.

1. Select multiple games

1. Enter selection mode by tapping the button at the top.
2. Now tap more games to select them.

2. Editing multiple games

1. Tap the “Action” button on the bottom right and choose “Edit”.
2. Select which fields you want to edit (scroll or use the search box to find them).
3. Tap “Edit” at the top right.
4. Now set values, or leave fields gray to clear them.
5. Tap “Done” at the top right to save the changes to the selected games.

Edit Multiple is the only feature in CLZ Games that can overwrite existing data. Use it with
great care.

!

You can tap the star/heart icons to set Favorite fields.*
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Managing Pick Lists
With every game you add to your collection, CLZ Games stores common information in Pick Lists. Examples
of pick lists include Genre, Format, Location, Owner, etc.

With the Manage Pick List screen you can modify all Pick List items. With it you can add, edit, delete and
merge List Items.

When do I use the Manage Pick Lists screen?
Below are some example situations to help you understand when you can use this screen to fix issues with
certain pick list fields.

Quickly fix bad spelled list items for multiple games in 1 go:

You may have added a “Platform” to a game and also already added that platform to many other games and
only find out now that it wasn’t spelled correctly. This may mean you already have tens and tens of games
with the bad spelled platforms.
The Manage Pick Lists screen can help you sort that out: Use it to find the platform in the platform list, and
edit the entry. Fix the spelling mistake, and when you’re done all games with that platform will now have the
new and correct spelling.

Use it to merge duplicate list items or a merge strange spelled formats in your list
items:

It can happen that duplicate list items appear in your app. It could be that we spell a developer name
differently than you have in the past.
Example: If you notice you have a duplicate developer (for instance the developer: “UbiSoft” and “Ubi-Soft”),
you can merge them using the Manage Pick List screen in the app to 1 single developer. Doing this will
instantly update all games that used one of those 2 developers to now show the new one.

How to add, edit, merge or remove pick list items:
You can add/edit/merge or remove pick list items. Pick what you wish to do:

• Adding a new pick list item
• Editing a pick list item

Any pick list item that you change will affect all games that use that value. For instance: you
can change the spelling of an “owner” name in Manage Pick Lists, which then instantly
modifies all games in your database that have that same owner name. Also, each game that
has that value in it will be marked up for a change when you sync with CLZ Cloud.

*
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• Merging pick list items
• Removing unused pick list items
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Adding a new pick list item
Method 1: Type it into the field in the Edit Screen of a game

When you edit a game and you type something new in one of the pick list fields, this automatically gets
added to your pick list for that field. Once a value has been entered in the list, you can just select it from a
list instead of retyping it every time.

Method 2: Use the Manage Pick List screen

1. From the menu, choose “Manage Pick Lists”.
2. Choose which list you want to work on.
3. Tap “New […]”.
4. Type it in and tap “OK”.

This new value can now be chosen for that field in any of your game’s Edit Screen.
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Editing a pick list item

Editing a pick list item:
1. From the menu, choose “Manage Pick Lists”.
2. Choose which list you want to work on.
3. Tap on any of the pick list items to edit it.

Warning: any change you make to an existing pick list item will affect all games that also
use that pick list item.

!
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Merging pick list items

Merging pick list items:
Accidentally got two or more pick list items that are the same? You can merge them:

1. From the menu, choose “Manage Pick Lists”.
2. Choose which list you want to work on.
3. Tap the menu button top right and choose “Enter merge mode”
4. Now select all entries that you wish to merge and tap “Merge to …”
5. Choose which item you wish to merge all these pick list items to and confirm.
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Removing unused pick list items

Removing unused pick list items:
You may have some pick list items that you don’t use anymore. You can remove them:

1. From the menu, choose “Manage Pick Lists”.
2. Choose which list you want to remove unused items from.
3. Tap the menu button top right and choose “Remove unused items”
4. Confirm the removal.
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Update from Core
When you add games using this app’s Add by Barcode or Add by Title tools, you get lots of game details
automatically from our central Core for Games online database.

After you add your games, the Core online data may change, e.g. to add more details that were not
previously available.
The Update from Core feature lets you update the games in your local database with the new information in
Core.

How to update your games with new data from Core

1. Press and hold on 1 game.
2. You are now in “Selection Mode”.
3. Select all games you wish to update from Core.
4. Tap the menu button bottom right.
5. From the menu, choose “Update (x) games from CLZ Core” and confirm.

Note: This method is only possible in list mode.

Note that Update from Core only ADDS information to fields that were still empty. It will
never overwrite existing data.

!
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Multiple collections
CLZ Games allows multiple sub-collections within your app. The collections will appear in the menu that you
can open from the top left, so that you can easily switch between them.

Create and manage collections

Open the menu top left and tap “Add Collection” or “Manage Collections” to create a new collection,
rename existing collections, remove a collection or change their order (drag and drop).

Moving game(s) to other collections

You can freely move one or multiple games between collections in your database file.

1. Tap and hold on a game (or multiple) and tap the blue circle button (with 3 dots)
2. Tap Move to other collection.
3. Select the collection you wish to move it/them in.

The option to move to other collection only appears if you have multiple collections (so use the menu top
right > Add Collection / Manage Collections to create an extra collection first).

Tap and hold only works in list view. Not in thumbnail view.

How do I sync my existing multiple collections from CLZ Cloud?

If you already have multiple collections in the CLZ Cloud, here’s what to do to get your existing entries split
up into multiple collections on your mobile app too:

1. Tap the menu top left
2. Tap “Sync with CLZ Cloud” and make sure you’re in sync.
3. Tap the menu top left again and tap “Maintenance”
4. Tap “Update all from CLZ Cloud”
5. Now use “Sync with CLZ Cloud” from the menu again.

Collectorz.com CLZ Games for Android - 2_en

Page 28 of 71



Game Values from PriceCharting
Find out which are the most valuable games in your collection, by downloading comic values from our Core
online game database, based on their Completeness. Values are updated daily from PriceCharting.com.

How to get values for your games:
1. Tap the menu top left and tap “Update PriceCharting Values”
2. Wait for it to finish!

Locking values
In the Edit Game screen on the value tab you will find a checkbox called “Lock”. When checked, the value
will never be overwritten with PriceCharting values when you update the game.

When are PriceCharting values filled in?
If you use “Update Values”, your Value fields will be filled in (and possibly overwritten) by PriceCharting
values if:

• A PriceCharting value is available for the grade you’ve set for that comic.
AND

• The Lock value field is switched off.

No PriceCharting value will be filled in if:

• If you have set the completeness of the game to N/A
and/or

• The Lock value field is switched on.

Existing values will be replaced by PriceCharting values unless you use the Lock Value
field!

!
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Browsing your database
• Collection vs Wish List
• Choosing View Modes
• Grouping into folders
• Sorting
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Collection vs Wish List
CLZ Games can not only keep track of the games in your collection, but it can also maintain a Wish List.
While adding games, you have the option to choose to add an item to “Collection” or to “Wish List”. If you
choose to add games to your “Wish List”, the item’s “Collection Status” field will be set to “Wish List”.

To quickly view all items on your Wish List, you can use the Collection Status Filter button and switch to
Wish List:

You can use the Collection Status Filters to view Games filtered by:

• All – Shows your entire collection
• In Collection – Shows games that are in your collection or For Sale
• On Wish List – Shows games on your Wish List and On Order

You can change the collection status of entries in your database via the Edit Game” screen.
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Choosing View Modes
CLZ Games has 2 view modes for your games:

1. List: Shows a small thumbnail of your game, the title and a couple of other pre-selected fields.
2. Cover Wall: View your collection by cover image.

Tap the 3 dots icon in the main screen and then “Switch View” to switch to List or Cover Wall:
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Grouping into folders
When you have a lot of games in your collection, it can be useful to group them together. You may want to
group your collection on platform so you can view all your PS4 games together, your Xbox One games
together and see how many games you actually own on each platform.

1. Tap on the Folder icon (top left of your screen) to view a list of available folders.
2. Tap on “Platform” and all your games will be instantly grouped on platform (the numbers behind each

platform indicate how many games you have on that platform).
3. Now tap on a platform to view all games you have on that platform.
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Sorting
With your games stored digitally in your mobile device you can quickly sort your list on a number of fields.

1. Tap the Sort button:
2. You now see the Sort Options.
3. Tap on the field you wish to sort your games on.

You can only sort on the fields you see presented in the Sort Options.

Choose ascending sorting (arrow up) or descending sorting (arrow down) by tapping on one
of the arrows.*
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Syncing with the CLZ Cloud

Contents:
• Why sign up?
• Synchronize with CLZ Cloud
• How the CLZ Cloud works
• Back up / Restore your collection and subscription
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Why sign up?
The subscription to the CLZ Games app comes with cloud storage for your data, in our own CLZ Cloud
system. To use your CLZ Cloud, you need a CLZ Account.

Advantages of using CLZ Cloud:

When you’re using CLZ Games, you can use the CLZ Cloud to:

• Make an online backup of your game collection data.
• Sync your game data between devices (e.g. your phone and tablet).
• Transfer your subscription across devices (one subscription for multiple phones/tablets).
• Sync data to/from our Game Collector or Game Connect software.

With your collection in the CLZ Cloud you will have a couple of advantages:

Your collection is backed up safely in the CLZ Cloud:

• View your collection online: You can visit your personal CLZ Cloud page to view your collection (in
any browser).

• Share with friends: You can send a viewing link to your friends so they can check out and browse your
collection (don’t worry, they can’t change anything to your collection).

You can restore/download your collection from the CLZ Cloud on any iOS or Android device:

• If for any reason your phone crashes or has been wiped clean, you can download your collection and
subscription back down to your device.

• Do you also own a tablet? Download your collection and use the same subscription on any other iOS
or Android device with CLZ Games. No extra costs.

• You can also sync your collection down to our Windows desktop software: Game Collector
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Synchronize with CLZ Cloud
CLZ Cloud is an online service for storing and backing up your collection database in the cloud. It is also
used to sync data between devices, e.g. from your Windows or Mac software to your app, but also between
phones and tablets.

If you own multiple devices, e.g. a phone and tablet, you will need a CLZ Account so that you can sync data
between your devices.
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Syncing your collection with CLZ Cloud

Windows / Mac

1. Click on menu “CLZ Cloud > Synchronize” or click this button on the toolbar:
2. The program will now check if there are any changes that need to be synced up or down.
3. Click the “Sync Changes” button to process all changes.

iOS / Android
1. Tap the menu top left and tap “Sync with CLZ Cloud”
2. The app will now check if there are any changes that need to be synced up or down.
3. Tap the “Sync Changes” button to process all changes.

If you’re getting any errors, please consult the troubleshooter.

If you cancel the sync at any point, or the connection gets interrupted, you can restart the
sync and it will continue where it stopped.*

If you cancel the sync at any point, or the connection gets interrupted, you can restart the
sync and it will continue where it stopped.*

Collectorz.com CLZ Games for Android - 2_en

Page 38 of 71



Uploading Images
Game Collector will try to upsync cover images for games that don’t already have a cover in the CLZ Cloud.
The images are restricted to 500kb in size, if your images are larger than this, they won’t be uploaded.

Images are only automatically upsynced to CLZ Cloud if:

• The image is below 500kb in size
• Your game is not linked
• We don’t already have a cover for that game
• The cover we have is of lower quality

If we already have a cover for your game the default image from Core for Games. That’s why” it’s important
to link your games”:#404 to the correct game in Core for Games (only possible on PC/Mac currently).

If you have a cover that you want to upsync to CLZ Cloud even though there’s already one in CLZ Cloud
you can do this using this method:

Manually Upload a Cover to CLZ Cloud

Windows/Mac

1. Edit the game
2. Click the “Images” tab and check the box for “Custom Image”

iOS/Android Mobile device

1. Select an game
2. Tap the pencil icon to edit the item.
3. Near the cover image check the box for “Custom Image”

Collectorz.com CLZ Games for Android - 2_en

Page 39 of 71



How the CLZ Cloud works
CLZ Cloud is a service for storing and backing up your collection database in the cloud. It is also the
recommended way for syncing data between devices, e.g. from your Windows or Mac Game Collector to
CLZ Games on iOS / Android, but also to sync between your mobile devices.

If you own multiple devices, e.g. iPad and iPhone, you will need a CLZ Account so that you can sync your
data through CLZ Cloud between your two devices.
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Back up / Restore your collection and
subscription
After storing so many games in CLZ Games it’s always smart to have a backup. It’s also useful if you can
restore your subscription on any device, any time. We offer you a way to do that by syncing your complete
database and subscription to the CLZ Cloud.

1. Back up your collection and subscription:
1. Open the menu top left and tap “Sync with CLZ Cloud”
2. The app will now check if there are any changes that need to be synced up or down.
3. Tap the “Sync Changes” button to start the backup and your games and subscription will now be

backed up to your CLZ Account in the CLZ Cloud.
4. If you don’t have a CLZ Account with us yet, the app will ask you to create one or log in. Follow the on

screen instructions to do so.

If you’re getting any errors, please consult the troubleshooter.

2. Restore/download your collection and subscription:
If you have a new device, installed the app anew, or are installing on a 2nd mobile device, you can
download your collection and your subscription from the CLZ Cloud:

1. Install CLZ Games on your device and start it.
2. Login with your CLZ Account. This instantly restores your subscription.
3. Open the menu top left and tap “Sync with CLZ Cloud”
4. Tap on “Sync Changes” to sync your collection from CLZ Cloud down to your device.

Advantages of backing up your collection and subscription:

With your collection and subscription in the CLZ Cloud you will have a couple of advantages:

Your collection is backed up safely in the CLZ Cloud:

• View your collection online: You can visit your personal CLZ Cloud page to view your collection (in
any browser).

• Share with friends: You can send a viewing link to your friends so they can check out and browse your
collection (don’t worry, they can’t change anything to your collection).

Make sure you sync your collection every once in awhile to maintain a good backup in the
CLZ Cloud with all your recent game additions.*
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You can restore/download your collection from the CLZ Cloud on any iOS or Android device:

• If for any reason your phone crashes or has been wiped clean, you can download your collection and
subscription back down to your device.

• Do you also own a tablet? Download your collection and subscription to any other iOS or Android
device with CLZ Games. No extra costs.

• You can also sync your collection down to our Windows desktop software: Game Collector
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Sharing online
If you want, you can share your collection with friends so they can see which games you have!

Your public CLZ Cloud link
To find out your public Cloud Share link, tap the menu icon top left and tap “View my CLZ Cloud”

Your browser app will open to show you your collection on CLZ Cloud.

1. Tap the person icon top right and log in! (same account as your CLZ App)
2. Now tap the menu top left and tap on “CLZ Cloud Sharing”
3. Find your Public Cloud Sharing link there!

Privacy
You can change your CLZ Cloud data visibility in the settings screen there to hide your collection partially or
completely from the outside world if you want.

To do this, click the menu icon top left and select “CLZ Cloud Sharing”.

Your CLZ Cloud Visibility options:

You will find 3 options under CLZ Cloud visibility, here’s what they mean:

Private Nothing shown to anyone, only visible when you’re logged in.

Partial Visible to everyone with your CLZ Cloud link, but no personal fields shown.

Public Visible to everyone with your CLZ Cloud link, including personal fields shown.

Private Cloud Sharing

When you set your Cloud data visibility to Private, you can still share it with a secret URL.

Under “Private Cloud Sharing”, use the Generate button to set up a a secret URL to share your private cloud
data with someone. If you generate a new URL, the previous one will be replaced. Press the X to disable
sharing via a private URL completely.
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Importing / Exporting
• Import from Text / CSV
• Export to Text / CSV
• Print your collection
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Import from Text / CSV
To perform a full import from a text or CSV file you can use the CLZ Cloud Import Tool. The steps consist of
first importing all items into CLZ Cloud, and then syncing those items from CLZ Cloud to CLZ Games on
your mobile device.

1. Importing your Text/CSV file to CLZ Cloud

1. Go to the CLZ Cloud website and log in with your CLZ Account.
2. Click the menu icon top left and click “Import Data” to enter the import screen.
3. Click “Import from Text / CSV File”.
4. Upload your Text / CSV file.
5. Change the data format settings so it looks correct under the preview.
6. Under “Select your Column fields” pick the fields to match your fields! Note that you can also skip

fields.
7. Click “Import games” to run the import.

Import problems?

If you’re having troubles with this, make sure you re-check step 4 to make sure all columns you’re importing
match a field that we provide.

If you can not match a field to one we have, you can decide to add that column of information to the notes of
each game or just skip that column altogether.

2. Syncing from CLZ Cloud to CLZ Games

After you’ve done the import you now need to get all those imported games from CLZ Cloud to CLZ Games
on your mobile device:

1. Start CLZ Games on your mobile device.
2. Open the menu, top left and tap “Sync with CLZ Cloud”
3. This will open the Sync screen, showing the number of changes to be downloaded.
4. Tap the Sync Changes button to start downloading your game data.

Done! You should now have all games in CLZ Games on your mobile device.

It is important that you match your text file to the fields we have. You do this in step 5
where you select the fields to import.*
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Export to Text / CSV
You can’t export directly from CLZ Games on your mobile device, but you can export from your CLZ Cloud
website.

1. On your mobile app:

1. Tap on the CLZ Cloud button on your toolbar or in the left side menu. to open the Sync screen.
2. Tap the Sync Changes button to start syncing your game data.

2. On your desktop computer (PC or Mac):

1. Go to your CLZ Cloud webpage and log in with the same account you use in CLZ Games on your
mobile device.

2. Click the Wrench icon top right and then click Export.
3. You can now select a sort order and the fields you’d like to include in the export.
4. Click Export at the bottom and download the resulting file.

Collectorz.com CLZ Games for Android - 2_en

Page 46 of 71

https://cloud.collectorz.com/games/


Print your collection
You can’t print directly from CLZ Games on your mobile device, but you can export from your CLZ Cloud
website and then print from a computer.

1. On your mobile app:

1. Tap on the CLZ Cloud button on your toolbar or in the left side menu. to open the Sync screen.
2. Tap the Sync Changes button to start syncing your game data.

2. On your desktop computer (PC or Mac):

1. Go to your CLZ Cloud webpage and log in with the same account you use in CLZ Games on your
mobile device.

2. Click the Wrench icon top right and then click Export.
3. You can now select a sort order and the fields you’d like to include in the export.
4. Click Export at the bottom and download the resulting file.
5. Import the file in a spreadsheet program like Numbers or Excel and print it from there.

Alternatively, save the trees and stop at step 2.1. You now have a webpage with all your
data right in front of you accessible from any online device!*
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Troubleshooting
• My app is suddenly locked, how do I fix this?
• Use your existing subscription
• CLZ Cloud Sync problems
• Need help?
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My app is suddenly locked, how do I fix this?
There can be a couple of reasons your app is locked. Please select the situation that applies to you:

1. Situation 1: I’ve paid for the app before.
2. Situation 2: I’m unable to sync my subscription back to my device.
3. Situation 3: I’ve never synced my purchase with a CLZ Account.
4. Situation 4: I’ve purchased the full price mobile app in the past.

I’ve paid for the app before.

The most basic way to unlock your purchase on a new device is to log in with your CLZ Account and sync
your purchase down:

1. Tap the top left icon to open the left side menu.
2. Tap “CLZ Account” at the top.
3. At the bottom, tap “I already have a CLZ Account”.
4. Enter your CLZ username and password and Log in.

This should sync your purchase back down to your device so you can use the app like before.

I’m unable to sync my subscription back to my device

If you’ve paid for the app before or you’re now trying to get the app to work on a different device but can’t,
please follow the steps below:

1. Start the app on the device you purchased the app with in the past.
2. Tap the top left icon to open the left side menu.
3. Tap “CLZ Account” at the top.
4. At the bottom, tap “I already have a CLZ Account”.
5. Enter your CLZ username and password and Log in.
6. Repeat steps 2-5 on any other device you want to unlock the app on.

I’ve never synced my purchase with a CLZ Account.

If you’re still unable to get your app unlocked, try the steps below:

Apple iOS

If you are on Apple iOS, you can open “Start Trial” screen and tap “Restore Purchase”.

After you get your in-app purchase back on your device, please make sure to login or
register with a CLZ Account on your device. That way we can keep your purchase safe on*
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Android

If you are on Android, we need 2 things from you so we can get you back up and running:

1. Your CLZ Account number or CLZ Account username or CLZ Account email address. If you do not
have a CLZ Account, please create one .

2. Your order number. You can find the order number on Google Payments . Select the in-app
purchase there to find the order number.

I’ve purchased the full price mobile app in the past (before version 5.x).

If you paid for the app before v5, you do not have to pay again: You are entitled to use the app with a free
Basic Level . Everyone who registered their app to their CLZ Account before automatically received a life-
time “Basic”-level subscription to access their existing CLZ Core and CLZ Cloud services.

If this did not happen for you, please contact us for further instructions so we can unlock the app for you.

our servers should you ever need it.

Send that information (CLZ Account and order number) to us through our contact form and
we’ll make sure to get you up and running again.*
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Use your existing subscription
If you’ve already purchased a subscription to CLZ Games before, here’s how you can use it on a different
mobile device:

1. Tap the top left icon to open the left side menu.
2. Tap “CLZ Account” at the top.
3. At the bottom, tap “I already have a CLZ Account”.
4. Enter your CLZ username and password and Log in.
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CLZ Cloud Sync problems
Pick the item you wish to know more about:

• Different number of movies in desktop, cloud and app
• Error: Database synced with different CLZ Account
• Error: Cleared collection in CLZ Cloud
• Error: Different database than the one in CLZ Cloud
• Errors in Sync Report
• SYNC FAILED: The old CLZ Cloud Sync system has been discontinued
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Different number of games in desktop, cloud
and app
In some rare situations, your desktop, cloud and mobile app database can get “out-of-sync”, causing a
different number of games to be listed.

The solution is simple, but may take some time. In short:

1. Clear your CLZ Cloud.
2. Upload your most up-to-date database to the CLZ Cloud
3. On all OTHER computers and mobile devices: re-download the data from the CLZ Cloud

Step 1: Clear your CLZ Cloud

1. Go to your CLZ Cloud page and log in.
2. Click the menu button top left and choose “Clear Database”

Step 2: Upload your most up-to-date database to the CLZ Cloud

Open the desktop program or mobile app that has your most up-to-date database and use Sync with CLZ
Cloud to upload that database to the CLZ Cloud.
For most users, we recommend uploading from the desktop software, as that is most likely to have the most
complete copy of your database.

Step 3. On all OTHER computers and mobile devices: re-download the data from
the CLZ Cloud

Do the following on all your OTHER devices and computers to download the new CLZ Cloud data:

In the CLZ mobile apps:

• tap the menu top left, and choose “Clear Database”.
• tap the menu top left and choose “Sync with CLZ Cloud”

In the desktop software:

• use File / New Database to start a new database, save it under a NEW filename.
• choose Synchronize from the CLZ Cloud menu.
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Error: Database synced with different CLZ
Account
The database you’re trying to sync with CLZ Cloud has been synced before, but to a different CLZ Account.
This can happen if you have more than one CLZ Account with us.

Solution 1: Login with the correct CLZ Account

Windows / Mac desktop software

1. Close the “Synchronize with CLZ Cloud” screen.
2. Click menu “Tools > My CLZ Account”.
3. Login with the correct CLZ Account that you previously used to sync this specific database with.

iOS / Android mobile device

1. Close the sync screen.
2. Go to the settings of the mobile app.
3. Open CLZ Account login details and login with the correct CLZ Account that you previously used to

sync this specific database with.

Solution 2: Clear your CLZ Cloud data
Alternatively to solution 1, you could also clear the database out of the CLZ Cloud and then perform the
sync once again. Here’s how:

1. Go to your CLZ Cloud page and log in.
2. Click the menu button top left and choose “Clear Database”
3. Go back to your mobile app and try syncing once again.
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Error: Cleared collection in CLZ Cloud
It seems you cleared your collection in CLZ Cloud, meaning you have logged into your CLZ Cloud and used
the red button named “Remove all games from database”.

You will be presented with the option to “Upload this database” meaning you are about to upload your entire
games database from your local computer or mobile device up into CLZ Cloud.

If you would like to continue you need to “Upload this database”.
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Error: Different database than the one in CLZ
Cloud
The database you’re trying to sync with CLZ Cloud is a completely different one than we have in the CLZ
Cloud. Perhaps you have opened a different database file?

Solution 1: Open the correct database
Open the same database that we have in CLZ Cloud for you. To verify, login to CLZ Cloud and check which
database is in there.

1. Close the “Synchronize with CLZ Cloud” screen.
2. Click menu “File > Open Database”.
3. Open the database that is the same as the one in the CLZ Cloud.
4. Try syncing again.

Solution 2: Clear your CLZ Cloud data
It could happen that you do not have that same database anymore, or for any reason at all you now wish to
sync this database you have in front of you instead of the one in CLZ Cloud.

So, alternatively to solution 1, you could also clear the database out of the CLZ Cloud and then perform the
sync once again. Here’s how:

1. Go to your CLZ Cloud page and log in.
2. Click the menu button top left and choose “Clear Database”
3. Go back to your the program/app and try syncing once again.
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Errors in Sync Report
It can happen that something goes wrong during sync. If that happens, you will be notified, and you can
check here what the error means:

• Error downloading/uploading cover
• Other Messages
• Clear database in CLZ Cloud

Error downloading/uploading cover:

A cover (or more than 1 cover) didn’t download or upload correctly.
Restart the CLZ Cloud sync to try again!

“Error Uploading cover” keeps coming back

If you keep getting the error uploading for the same cover every time you sync, and you have a stable
internet connection, it could be that the cover image is corrupt.

Find the actual cover for that game on your PC/Mac or iOS/Android mobile device and see if it’s actually
there:

• If the image seems bad, remove the image and add a new image to the game
• If it seems fine and it keeps failing, it might be too big or corrupt (but you can’t actually see it’s

corrupt). Try to remove the image and add a new image to the game.

Other messages:

If you get any error messages, restarting the CLZ Cloud sync will usually do the trick, so always try that first!

This database was exported directly from Game Collector and can not be synced with CLZ Cloud.

To enable CLZ Cloud 2.0 syncing please empty your database on your mobile device first using “Settings >
Empty Database”.

There are no changes to be synchronized with CLZ Cloud.

No changes were found between your local database and your database in CLZ Cloud.
If, however, you are sure it should be syncing, you could opt to clear your DB in CLZ Cloud (this forces an
upsync from any device/pc up into the CLZ Cloud).

Clear database in CLZ Cloud

Here’s how you can, if you want, clear your database in CLZ Cloud:

Collectorz.com CLZ Games for Android - 2_en

Page 57 of 71



1. Go to your CLZ Cloud page and log in.
2. Click the menu button top left and choose “Clear Database”
3. Now try syncing once again. .
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Warning: Database originates from Direct
Export
“Your database originates from a direct export from PC/Mac. Any additions or changes to this database
cannot be synced back to CLZ Cloud or your PC/Mac.”

CLZ Cloud sync doesn’t work if the database on your mobile device originated from a “Direct Export” from
your PC or Mac as that could cause errors in your database. To fix this problem, you have to clear your
database on your mobile device and from now on use CLZ Cloud syncing to get your games in your CLZ
Games for your mobile device.

Steps to fix this problem:
1. Make absolutely sure you have your latest data in your desktop software.
2. On your mobile app: tap on the settings wrench/gear button in CLZ Games.
3. Tap on Empty Database.
4. Now start your PC/Mac software and click CLZ Cloud > Synchronize.
5. On your mobile app: tap the CLZ Cloud button, and sync with CLZ Cloud.

From now on you should only use CLZ Cloud syncing to get your games onto your mobile
device and back on your PC/Mac. If you use Direct Export from your PC/Mac again after
this, you will run into this error again.

!
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I do not see my own cover images after
syncing.
When you sync with CLZ Cloud, the cloud entries will, in general, use the central cover images from Core
for Games. Only if you’ve manually modified or added a cover yourself it will be marked as Custom Image
and syncs with your CLZ Cloud.

Sync Custom Images
Custom Images sync with CLZ Cloud. A front cover image is marked as “Custom Image” automatically when
you:

• Use the “Find Cover” screen
• Browse for a new front cover on your computer
• Drag and drop a new front cover on your game
• Acquire a new front cover using your image scanner

Marking images as “Custom Image”
Marking images as “Custom Image” is done automatically by Game Collector V19 and up.

If you find that you have some custom images that aren’t syncing with CLZ Cloud, you can mark them as
“Custom Image” yourself:

1. Edit the game an go to the covers tab
2. Check the box for “Custom Image”

That’s all, the custom image will now be synced the next time you sync with CLZ Cloud.

To sync your own cover with older versions (pre-v19) of Game Collector you have to right click the game
and select “Upload Cover”.

Force upload a cover with the mobile app

In the mobile app you can force upload your cover by editing the game and then tap the checkbox for
“Custom Image”, and then sync.

You can use Tools > Maintenance > Auto Mark Custom Images to check your entire
collection for custom images, you only have to do this once. This feature is not available on
Music Collector.
*
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Need help?
If you can’t find your answer here, please don’t hesitate to contact us via e-mail.

You can find a contact form on the CLZ Mobile website.
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Reference
• Your CLZ Account
• Settings
• Requirements
• Direct import from Game Collector
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Your CLZ Account
What is a CLZ Account?

A CLZ Account is a generic Collectorz.com customer account, a login (a CLZ Username and Password) for
several different Collectorz.com online services:

• Log in to the My.CLZ.com site to access your licenses, subscriptions and download links
• Syncing your database with the CLZ Cloud.

Creating a CLZ Account

To sync your database with the CLZ Cloud you will need a CLZ Account. Creating a CLZ Account can be
done straight from the CLZ Games. If you already use Connect, or you own a subscription for our desktop
software, then you probably already have a CLZ Account.

Tap “CLZ Account” from the menu top left to create a new CLZ Account or log in to an existing one.
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Settings
You can reach the settings screen by tapping the Menu > Settings.

Appearance
Application Skin
Change the skin of the entire app to light or dark.

Details View Template
Change the details page of a game to a different style and color.

Add Books from CLZ Core
Primary and Secondary Region
If a book can’t be found directly in our CLZ Core book database, the app will expand the search to public
online libraries from these countries. Set up a first and second country.

Barcode Scanning
Manual focus
Tap the screen to focus on the barcode

Sound
Play a sound when scanning a barcode.

Vibrate
Vibrate when scanning a barcode.
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Requirements
To get the most out of CLZ Games, make sure you at least have:

• An Android running Android OS 5.0 or up.
• An Internet connection (only while adding/automatically updating games or syncing with CLZ Cloud).
• For barcode scanning: A device with a camera that can do AutoFocus.

If you do not see the “Scan Barcode” button in the app it means the camera on your device
does not have auto-focus.

!
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How much space does the app require?
CLZ Games itself takes a little less than 18 MB (phone) or 12 MB (tablet) of space on your device.
Depending on how many games you’re going to catalog, the app will require a more space on your device.

Below you will find an indication of how much extra space you need, depending on how many games you’re
going to store in the app. Note that this amount may vary depending on if you have covers for each game –
it’s an estimate:

Estimated additional space needed on Phone:

100 items 1.000 items 10.000 items

CLZ Movies 17 MB 168 MB 1680 MB

CLZ Books 9 MB 91 MB 915 MB

CLZ Music 9 MB 87 MB 879 MB

CLZ Comics 18 MB 175 MB 1754 MB

CLZ Games 23 MB 222 MB 2222 MB

Estimated additional space needed on Tablet:

100 items 1.000 items 10.000 items

CLZ Movies 25 MB 250 MB 2500 MB

CLZ Books 8 MB 75 MB 750 MB

CLZ Music 7 MB 70 MB 700 MB

CLZ Comics 14 MB 140 MB 1400 MB

CLZ Games 15 MB 150 MB 1500 MB

The app uses your device memory to store the additional data. The data can not be moved to an SD-card.
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Direct import from Game Collector

Here’s how to transfer data from the Game Collector desktop software to CLZ Games using the old Export/
Import method:

Importing over a local Wi-Fi connection:
• Tap the menu top left
• Tap “Maintenance”
• Tap “Old Import from Game Collector”

Your device is now ready to receive the data.

• In Game Collector click File > Export to > CLZ mobile application
• Select Export directly to device
• Click on your device name in the list of available mobile devices
• Select All Games and choose whether you’d like to replace or update your collection
• Click Start Export to begin exporting your database.

Depending on the size, this could take a while.

NOTE: If the Start Export button remains grey, please ensure you’ve clicked your device name from the list
of available devices.

Import using a USB connection:
There are 2 steps to importing via USB.

1. Export to ZIP file.
2. Importing into CLZ Games on your Android.

1. Exporting your Game Database to a ZIP file

• In Game Collector click File > Export to > CLZ Mobile application
• Connect your Android to your computer as a USB storage device

This feature is only available for backwards compatibility. It is not developed or supported
anymore. To transfer data from Game Collector, we strongly recommend to use the CLZ
Cloud syncing!.

!

Can’t find your device? Please consult the troubleshooter.*

Collectorz.com CLZ Games for Android - 2_en

Page 67 of 71



• Click Export to File

• Click Browse and select your Desktop to export the ZIP to.
• Click All {ITEMS and click Start Export
• A zip file will be created on your desktop

• Locate the zip, it will be called ‘clzgamedata.zip’
• Copy this file to the Root Directory of either your Android device or SD card

2. Importing ‘clzgamedata.zip’ into CLZ Games

After you’ve successfully exported your collection to a zip file, it’s now time to import into CLZ Games

• Open CLZ Games on your Android device.
• Tap the menu, then “Maintenance”, then “Old Import from Game Collector”
• IF you placed the ‘clzgamedata.zip’ correctly on the Root Directory of either your Android device or

SD card, the app should now ask you if you wish to import, so tap OK.

If you aren’t sure how to enable USB storage mode on your device you may need to contact
the manufacturer.*
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Export to CLZ Games: “Device not found”
If you can’t find your mobile device running CLZ Games using the “File > Export to > CLZ Mobile” with WiFi,
there’s a few possible causes you can check to making it work:

Contents

1. Make sure you have Bonjour installed
2. CLZ Games is not on the import page
3. Your WiFi may be disabled or automatically disconnected
4. Firewall software is blocking the connection
5. WiFi Router problems
6. Device is not on the same “subnet” as your computer
7. Alternatives to WiFi export

1.Make sure you have Bonjour installed

If you have Windows and you want to export to CLZ Games, you need to have “Bonjour” installed in order
for your Windows computer to talk with CLZ Games. The program basically connects CLZ Games to Game
Collector

• If you have iTunes installed on your computer, you have Bonjour installed too.
• If you don’t know if you have Bonjour installed, please download Bonjour and install it, then try

exporting via WiFi again.

You can also try to restart Bonjour if you’re on Windows:

1. Click the “Start” button located at the bottom of the desktop screen and type “Services” in the search
field above the Start button.

2. Click the “Services” tab in the Programs section of the pop-up menu to run the Services tool.
3. Right-click on “Bonjour Service” and select “Restart” on the shortcut menu.

If you’re on Mac, you don’t have to try to restart Bonjour.

2. CLZ Games is not on the import page

Make sure CLZ Games app is actually on the import page. To reach the import page:

• Tap the menu, then “Maintenance”, then “Old Import from Game Collector”

Unstable WiFi connection: Move closer to your WiFi access point.
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3. Your WiFi may be disabled or automatically disconnected

After a few minutes your mobile device could become idle and disable its WiFi automatically). To fix this, go
to your mobile device preferences screen and in “General” or “Wifi“Settings” switch off “Auto Lock” – or
something similar that locks your device after a few seconds (or even minutes).

4. Firewall software is blocking the connection

Make sure that your Collectorz.com software is allowed to connect “through” your firewall. Any new
(updated) version of Game Collector can actually cause your firewall to start blocking the connection.

Try switching off all firewalls, and be sure not to forget the Windows firewall. Also disable Windows
Defender if you are on Vista, Windows 7 or Windows 8

5. WiFi Router problems

If the above suggestions didn’t do anything for you the problem is most likely caused by your router.

First, try powercycling the router (disconnect it from power, wait 10 seconds, then reconnect).

If that doesn’t help, check if the manufacturer has any firmware updates available for your router. Updating
the firmware to the latest version could also resolve connection problems.
Please keep in mind that any new (updated) version of Game Collector can actually cause your router (or
router’s internal firewall) to start blocking the connection.

6. Device is not on the same “subnet” as your computer

The device (iOS/Android) needs to be on the same home network, and the same subnet as your computer.
To find out if they are, follow the steps below:

iPhone, iPod touch, iPad

1. On your iPhone or iPod touch go to Settings
2. Choose Wi-Fi
3. There you see your network with a check in front of it, tap on the blue arrow on the right
4. On this screen you see your IP Address and the subnet Mask of your device

Android

1. On your Android go to Settings
2. Choose Wi-Fi Settings
3. There you see your network (where it says “Connected”), tap it once
4. On this popup or screen you will see your IP Address.
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Windows:

1. On your computer, press Windows Key + R (Or go to start, choose run)
2. Typ “cmd /k ipconfig /all”
3. On this screen you see your IP Address and the subnet Mask of your computer

Mac OS X:

1. On your Mac, click the Apple logo top left of your screen and select “System Preferences”
2. Click on the Network icon.
3. Select your Internet Connection from the list. You have to be sure which one you are using
4. Click “Advanced”
5. Select the TCP/IP tab
6. On this screen you see your IP Address and the subnet Mask of your Mac

Comparing the address/subnet of iOS/Android versus the address/subnet of Windows/Mac

The IP address of your device and computer should almost be the same. Your IP address will consist of 4
groups of numbers. Example:
Computer IP address: 192.168.1*.102 and    mobile device IP address: 192.168.1*.108

As long as the first 3 groups of numbers (in this case “192.168.1”) are the same, you can assume you are
on the same network. If this is not the case, your mobile device is on a different network than your
computer! Fix this and the WiFi export should start working.

7. Alternatives to WiFi export

Alternatively to WiFi export you can use:

• Export to File (it’s located in the same screen). Then put the file on your mobile device and import like
that.

• Recommended: Sync via CLZ Cloud
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